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D9040DPPC DisplayPort   

Compliance and Validation  

Test Application 
Keysight D9040DPPC Software Version 4.2.0.0 

 

Release Date: March 6, 2023 

Requirements Category (e.g., operating system): Microsoft Windows 10, Microsoft Windows 7 

Requirements Category (e.g., minimum instrument 

software version): 

11.30.00406 (UXR-Series) 

06.73.00102 (90000 Series, 90000 X-Series, 

90000 Q- Series, V-Series, and Z-Series) 

VESA Eye Test Tool Version: 0.69 

File Name: SetupD9040DPPC_DisplayPort_4.2.0.0.exe 

Licenses: Please see the product data sheet on Keysight.com. 

 

New Features / Additions 

- Modified the measurement procedure of Source Peak to Peak Voltage Test. Now, VPP is defined 

as difference between VMAX and VMIN instead of VTOP and VBASE. 

- Added RefSink CTS Setup to the app installer. 
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Issues Fixed 

- Fixed the issue wherein "wrong polarity" error message was not appearing on the manager app 

in disaggregation mode. 

- Fixed the “PatternFirstUIFromLastHalf_VH” value in the “Standard Mode” Eye Diagram Test. 

- Fixed the error that appeared while running the Eye Diagram Test with "Exclude Random Jitter 

and Noise Derate (TP3_EQ)" option enabled in the Configure tab. 

 

Notes / Recommendations 

- When upgrading the Infiniium version to 6.40 or above, it is recommended to reinstall the 

DisplayPort application. 

- The CTS numbering in the test name for DisplayPort 1.4a is still based on the DisplayPort CTS 

1.2b. 

- The Result Append/Replace/Cancel message might not appear even when the user re- run’s the 

DisplayPort application with existing result. 

- The test result might not be replaced even after the user has selected “Replace” for the Result 

Append/Replace/Cancel message. 

o Work Around: Please delete the test result manually before re-running the test if you 

wish to “Replace” the existing test result. 

- User might not be able to find the fifth harmonic while carrying out the Level and Equalization 

Verification Testing with SSC. 

o Work Around: Please update the “FFT Peak Search Threshold” configuration variable 

under Debug mode to a lower value. So that, the peak search threshold level is between 

the peaks and the noise floor of the FFT signal. 

- User might experience error in running the Intra Pair Skew Test if the skew is large between the 

positive single-ended signal and negative single-ended signal. 

- The settings of the switch matrix are not reset, and there is no prompt to enter a new address if 

the user has selected “No” when loading the project with switch matrix enabled. 

- User might experience error when exporting the results to repository. 
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- User will experience error while running the Capture Mode or Analyze Mode with switch matrix 

enabled. 

- User might experience missing waveform file error or measurement error in the Analyze Mode. 

o Work Around: Please re-launch and configure the DisplayPort application to Analyze 

Mode after the Capture Mode is completed. 

- User will experience error while running the Eye Diagram Test (TP_RX_DFE) with Capture Mode 

or Analyze Mode. 

o Work Around: Please run the Eye Diagram Test (TP_RX_DFE) with Standard Mode. 

- Multiple Instances (Measurement Server) configuration might not run if the instance is remotely 

configured from Single instance to Multiple instances for the first time. 

o Work Around: Please re-run the remote configure script to configure the instance(s) 

from Single to Multiple. 

- The Select Tests tab may not show any tests available after saving “Measure, Report” type 

project with switch matrix enabled. 

o Work Around: Please relaunch the Test Setup and Connection Setup dialog box before 

saving the project with switch matrix enabled. 
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Keysight D9040DPPC Software Version 4.1.0.0 

 

Release Date: February 11, 2022 

Requirements Category (e.g., operating system): Microsoft Windows 10, Microsoft Windows 7 

Requirements Category (e.g., minimum instrument 

software version): 

11.25.00101 (UXR-Series) 

06.71.00202 (90000 Series, 90000 X-Series, 90000 Q- 

Series, V-Series, Z-Series) 

VESA Eye Test Tool Version: 0.69 

File Name: SetupInfDisplayPort04010000.exe 

 

New Features/Additions 

- Supports MX0105A Probe Head. 

- Supports subscription license for bundled software. [SW00DSPP, SW02DSPP] 

 

Issues Fixed 

- Fixed the slow performance issue in eye diagram test. 

 

Notes/Recommendations 

- When upgrading the Infiniium version to Infiniium 6.40 and above, it is recommended to reinstall 

the DisplayPort application. 

- VESA DP Eye Test tool is mandatory to run Eye Diagram Test (TP_RX_DFE). This tool is not a 

part of the application installer package, and therefore must be separately downloaded and 

installed from VESA website before running the test. 
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- When running the application in Multiple Instances (Measurement Server) configuration, please 

ensure that the Infiniium software is running on all the machines participating in the 

measurement system, that is, the manager PC, worker PCs, oscilloscopes, and the reporter PC. 

 

Known Issues 

- The CTS numbering in the test name for DisplayPort 1.4a is still based on the DisplayPort CTS 

1.2b. 

- The Result Append/Replace/Cancel message might not appear even when the user re- run’s the 

DisplayPort application with existing result. 
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- The test result might not be replaced even after the user has selected “Replace” for the Result 

Append/Replace/Cancel message. 

o Work Around: Please delete the test result manually before re-running the test if you 

wish to “Replace” the existing test result. 

- User might not be able to find the fifth harmonic while carrying out the Level and Equalization 

Verification Testing with SSC. 

o Work Around: Please update the “FFT Peak Search Threshold” configuration variable 

under Debug mode to a lower value. So that, the peak search threshold level is between 

the peaks and the noise floor of the FFT signal. 

- User might experience error in running the Intra Pair Skew Test if the skew is large between the 

positive single-ended signal and negative single-ended signal. 

- The settings of the switch matrix are not reset, and there is no prompt to enter a new address if 

the user has selected “No” when loading the project with switch matrix enabled. 

- User might experience error when exporting the results to repository. 

- User will experience error while running the Capture Mode or Analyze Mode with switch matrix 

enabled. 

- User might experience missing waveform file error or measurement error in the Analyze Mode. 

o Work Around: Please re-launch and configure the DisplayPort application to Analyze 

Mode after the Capture Mode is completed. 

- User will experience error while running the Eye Diagram Test (TP_RX_DFE) with Capture Mode 

or Analyze Mode. 

o Work Around: Please run the Eye Diagram Test (TP_RX_DFE) with Standard Mode. 

- Multiple Instances (Measurement Server) configuration might not run, if the instance is remotely 

configured from Single instance to Multiple instances for the first time. 

o Work Around: Please re-run the remote configure script to configure the instance(s) 

from Single to Multiple. 

- The Select Tests tab may not show any tests available after saving “Measure, Report” type 

project with switch matrix enabled. 



7 / 72  Keysight D9040DPPC DisplayPort Compliance and Validation Test Application Release Notes 

 

 

 

 

o Work Around: Please relaunch the Test Setup and Connection Setup dialog before 

saving the project with switch matrix enabled. 
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Keysight D9040DPPC Software Version 4.0.0.0 

 

Release Date: 21 June 2021 

Requirements Category (e.g., operating system): Microsoft Windows 10, Microsoft Windows 7 

Requirements Category (e.g., minimum instrument 

software version): 

10.25.01001 (UXR-Series) 

06.55.00902 (90000 Series, 90000 X-Series, 90000 Q- 

Series, V-Series, Z-Series) 

VESA Eye Test Tool Version: 0.69 

File Name: SetupInfDisplayPort04000000.exe 

 

New Feature 

- Supports Multiple instances (Keysight D9010AGGC Compliance Test Software Measurement 

Server) and Single instance with following test execution phases: 

o Acquire, Measure, Report – Applicable to multiple and single instances both 

o Acquire – Applicable to single instance only 

o Measure, Report – Applicable to single instance only 

 

     NOTE 
“Keysight D9010AGGC Compliance Test Software Measurement Server” 

allows to use multiple machines/PCs over a network as acquisition engines 

and processing engines in order to significantly enhance the test execution 

speed. To know more, please see the D9010AGGC product page on 

keysight.com (http://www.keysight.com/find/d9010aggc). 

 

Modification 

- Removed the “Sample”, “Negative Peak”, and “RMS” options from the “FFT Detector Type” 

configuration variable. 

http://www.keysight.com/find/d9010aggc
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Issues Fixed 

- Fixed the issue in which the test status icon was either not being updated or missing, and 

therefore actual test status was not being reflected. 

- Fixed the issue related to error in performing vertical settings enhancement of the input signal 

to fit the screen of the oscilloscope in Analyze Mode when Capture Mode and Analyze Mode are 

used with single-ended tests. 

- Fixed the issue of incorrect single-ended minus signal waveform saved for the Capture Mode 

and Analyze Mode in Infiniium 10.25. 

- Fixed the issue of missing unit for Sink Total Jitter Test and Sink Non ISI Jitter Test for Lane 0 

and Lane 2. 

- Fixed the issue of missing unit for Cable Total Jitter Test and Cable Non ISI Jitter Test for Lane 0 

and Lane 2. 

 

Notes 

- When upgrading the Infiniium version to Infiniium 6.40 and above, it is recommended to reinstall 

the DisplayPort application. 

- VESA DP Eye Test tool is mandatory to run Eye Diagram Test (TP_RX_DFE). This tool is not a 

part of the application installer package, and therefore must be separately downloaded and 

installed from VESA website before running the test. 

- When running the application in Multiple Instances (Measurement Server) configuration, please 

ensure that the Infiniium software is running on all the machines participating in the 

measurement system, that is, the manager PC, worker PCs, oscilloscopes, and the reporter PC. 

 

Known Issues 

- The CTS numbering in the test name for DisplayPort 1.4a is still based on the DisplayPort CTS 

1.2b. 

- The Result Append/Replace/Cancel message might not appear even when the user re- run’s the 

DisplayPort application with existing result. 
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- The test result might not be replaced even after the user has selected “Replace” for the Result 

Append/Replace/Cancel message. 

o Work Around: Please delete the test result manually before re-running the test if you 

wish to “Replace” the existing test result. 

- User might not be able to find the fifth harmonic while carrying out the Level and Equalization 

Verification Testing with SSC. 

o Work Around: Please update the “FFT Peak Search Threshold” configuration variable 

under Debug mode to a lower value. So that, the peak search threshold level is between 

the peaks and the noise floor of the FFT signal. 

- User might experience error in running the Intra Pair Skew Test if the skew is large between the 

positive single-ended signal and negative single-ended signal. 

 

- The settings of the switch matrix are not reset, and there is no prompt to enter a new address if 

the user has selected “No” when loading the project with switch matrix enabled. 

- User might experience error when exporting the results to repository. 

- User will experience error while running the Capture Mode or Analyze Mode with switch matrix 

enabled. 

- User might experience missing waveform file error or measurement error in the Analyze Mode. 

o Work Around: Please re-launch and configure the DisplayPort application to Analyze 

Mode after the Capture Mode is completed. 

- User will experience error while running the Eye Diagram Test (TP_RX_DFE) with Capture Mode 

or Analyze Mode. 

o Work Around: Please run the Eye Diagram Test (TP_RX_DFE) with Standard Mode. 

- Multiple Instances (Measurement Server) configuration might not run, if the instance is remotely 

configured from Single instance to Multiple instances for the first time. 

o Work Around: Please re-run the remote configure script to configure the instance(s) 

from Single to Multiple. 

- The Select Tests tab may not show any tests available after saving “Measure, Report” type 

project with switch matrix enabled. 

o Work Around: Please relaunch the Test Setup and Connection Setup dialog before 

saving the project with switch matrix enabled. 
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Keysight D9040DPPC Software Version 3.80 

 

Released Date: 19 November 2020 

Requirements category (e.g., operating system): Microsoft Windows 10, Microsoft Windows 7 

Requirements category (e.g., minimum instrument 

software version): 

10.25.01001 (UXR-Series) 

06.55.00504 (90000 Series, 90000 X-Series, 90000 Q- 

Series, V-Series, Z-Series) 

VESA Eye Test Tool Version 0.69 

File Name: SetupInfDisplayPort03800000.exe 

 

New Features 

- Supports Infiniium Oscilloscope Software version 6.55. 

- Supports Infiniium Oscilloscope Software version 10.25 for UXR-Series oscilloscope. 

- Supports DP 1.4a PHY CTS Version 1.1, Draft 4 for DP 1.4a and DPoC 1.4a Test Specification. 

o Updated the default value for "FFT Detector Type" configuration variable value from 

"Positive Peak" to "Average" 

o Updated the default value for the “SSC Filter Frequency” configuration variable from 

1.98MHz to Auto for Main Link Frequency Compliance, SSC Modulation Frequency Test, 

SSC Modulation Deviation Test, SSC Deviation HF Variation Test. 

o Updated the default sliding window width for SSC Deviation HF Variation Test from 1us 

to 0.5us. 

o Split the Main Link Frequency Compliance test into Main Link Frequency Compliance 

(SSC Enabled) and Main Link Frequency Compliance (SSC Disabled) 

o Updated the test limit for Main Link Frequency Compliance (SSC Disabled) from [- 5300, 

300]ppm to [-300, 300]ppm 
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o Updated the test limit for SSC Modulation Deviation Test from [-5000, 0]ppm to [- 5300, 

300]ppm 

- Supports DP 1.4a PHY CTS r1.0 E1 SCR for DP 1.4a and DPoC 1.4a Test Specification. 

o Supports DP 1.4a HBR2 Rj SCR for DP 1.4a and DPoC 1.4a Test Specification (Included 

in DisplayPort Version 3.76) 

▪ Updated the test limit for HBR2 RJ from 0.13UI to 0.23UI. 
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o Updated the allowable CTLE DC Gain for HBR3 range from 0 - -9 dB to 0 - -8dB. 

o Updated the Eye Diagram Test (TP2_CTLE), Total Jitter Test (TP2_CTLE) and Non ISI 

Jitter Test (TP2_CTLE) as informative tests for DP 1.4a and DPoC 1.4a Test Specification. 

- Supports DP 1.4a PHY CTS r1.0 DFE SCR for DP 1.4a and DPoC 1.4a Test Specification. 

o Supports the Eye Diagram Test (TP3_DFE) that run with VESA Eye Test Tool. 

o Removed the Eye Diagram Test (TP_RX_DFE) that run with VESA Eye Test Tool. 

- Supports DP 1.4a PHY CTS r1.0 UDJ_LF SCR for DP 1.4a and DPoC 1.4a Test Specification. 

o Supports Low Frequency Uncorrelated Deterministic Jitter Test for HBR3 as informative 

test 

Modification 

- Updated the application to check for the conflict of channel selection in Dual Mode Tests. 

- Updated the DisplayPort Alt Mode image file for the N7018A. 

- Disable the Capture Mode and Analyze Mode if switch matrix is enabled. 

 

Bug Fixes 

- Fixed the issue of Analyze Mode: Simulation Waveform unable to run with Single-Ended 

waveform. 

- Fixed the issue of project is not loaded correctly when loading the Analyze Mode: Simulation 

Waveform project. 

- Fixed the issue of Test Specification is not default to 1.4a when the user creates new project. 

- Fixed the issue of settings conflict warning message when the user creates new project. 

- Fixed the issue of default DP 1.4a script file (Script_method_1_v1.4.aux) is not selected after the 

application launched. 

- Fixed the issue of DisplayPort application crashes if the application is remotely configured for 

multiple time. 



 

 

Keysight D9040DPPC DisplayPort Compliance and Validation Test Application Release Notes 14 / 72 

 

 

- Fixed the issue of Channel Selection Setting Conflict message prompted twice. 

- Fixed the issue of undefined file extension in generating the transfer function for custom fixture 

de-embedding if the s-parameter file used contains the capitalized file extension (*.S2P, *.S4P). 

- Fixed the issue of 0.0 UI Non ISI Jitter result is reported if the EZJIT plus unable to perform jitter 

separation in Non ISI Jitter Test, Non ISI Jitter Test (TP2_CTLE) and Non ISI Jitter Test 

(TP3_CTLE). 

- Fixed the issue of incorrect mask file loaded for AUX Channel Eye Test. 

- Fixed the issue of incorrect maximum limit of Aux Channel Peak to Peak Voltage Test for Sink 

from 0.40V to 1.38V for DP 1.4a and DPoC 1.4a. 

- Fixed the issue of error in exporting the test result in PDF format. 

 

 

Note 

- When upgrading the Infiniium version to Infiniium 6.40 and above, please reinstall the 

DisplayPort application. 

- The user MUST manually download the VESA DP Eye Test tool from VESA website if they want 

to run the Eye Diagram Test (TP_RX_DFE) tests. 
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Known Issue 

- The CTS numbering in the test name for DisplayPort 1.4a still based on the DisplayPort CTS 

1.2b. 

- User might experience issue when incorrect probe head configured when running the 

DisplayPort application with Infiniium 6.55.00504. 

o Please disable the probe check via “Probe Check (Physical Layer Tests)” configuration 

variable under Debug mode. 

- User will experience error when run the Capture Mode or Analyze Mode with switch matrix 

enabled. 
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- User might experience missing waveform file error or measurement error in the Analyze Mode. 

o Please relaunch and configure the DisplayPort application to Analyze Mode after the 

Capture Mode completed. 

- The Result Append/Replace/Cancel message might not appear even user re-run the DisplayPort 

application with existing result. 

- User might experience the test result do not get replaced even user select “Replace” for the 

Result Append/Replace/Cancel message. 

o Please delete the test result manually first before re-run the test if the user wishes 

to “Replace” the existing test result. 

- User will experience error if running the Eye Diagram Test (TP_RX_DFE) with “Capture Mode” or 

“Analysis Mode”. 

o Please run the Eye Diagram Test (TP_RX_DFE) with “Standard Mode”. 

- User might experience the issue of unable to find the fifth harmonic when running the Level and 

Equalization Verification Testing with SSC enabled. 

o Please update the “FFT Peak Search Threshold” configuration variable under Debug 

mode to lower value so the peak search threshold level is between the peaks and the 

noise floor of the FFT signal. 

- User might experience error in running the Intra Pair Skew Test if the skew is large between the 

positive single-ended signal and negative single-ended signal. 

- The settings of the switch matrix are not reset and no prompted to enter new address if the user 

select “No” and expect to be prompted to enter new address when loading the project with 

switch matrix enabled. 

- User might experience error when exporting the results to repository. 
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Keysight D9040DPPC Software Version 3.76 

 

Released Date: 18 June 2019 

Requirements category (e.g., operating system): Microsoft Windows 10, Microsoft Windows 7 

Requirements category (e.g., minimum instrument 

software version): 

10.10.04514 (UXR-Series) 

06.55.00504 (90000 Series, 90000 X-Series, 90000 Q- 

Series, V-Series, Z-Series) 

VESA Eye Test Tool Version 0.69 

File Name: SetupInfDisplayPort03760000.exe 
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New Features 

- Supports Infiniium Oscilloscope Software version 6.40. 

- Supports Infiniium Oscilloscope Software version 6.55. 

- Supports Infiniium Oscilloscope Software version 10.10 for UXR-Series oscilloscope. 

- Supports DP_TX_DFE_Normative_SCR for DP 1.4a and DPoC 1.4a Test Specification. 

o Supports Eye Diagram Test (TP_RX_DFE) tests that run with VESA Eye Test Tool. 

▪ TP_RX Model: HBR3_Reference_Sink_5dB_rev1p0.s4p 

o Removed the Eye Diagram Test (TP3_DFE) and Eye Diagram Test with No Cable Model 

(TP3_DFE). 

- Supports DP 1.4a HBR2 Rj SCR for DP 1.4a and DPoC 1.4a Test Specification. 

▪ Updated the test limit for HBR2 RJ from 0.13UI to 0.23UI. 

- Supports VESA Eye Test Tool for Eye Diagram Test (TP3_DFE) and Eye Diagram Test with No 

Cable Model (TP3_DFE). 

- Supports the use of Channel Power to measure the 1st Harmonic and 5th Harmonic FFT Peak 

Magnitude in Level and Equalization Verification Testing tests. 

Modification 

- Updated the product number from “U7232E” to “D9040DPPC” to support PPKS license. 

- Updated the minimum value for the “FFT Resolution (kHz)” configuration variable from 10kHz to 

1kHz. 

Bug Fixes 

- Fixed the issue of DisplayPort application “Analyze Mode: Analyze captured waveforms” do 

not works with Infiniium 10 (UXR-Series oscilloscope). 

- Fixed the issue of the USB Type-C Controller settings are not loaded during project loading. 
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- Fixed the issue of Level and Equalization Verification Testing Tests are missing. 

- Fixed the issue of incorrect result for Total Jitter Test with No Cable Mode (TP3_EQ) – 

PRBS 7 for HBR if the test is run together with Total Jitter Test (TP3_EQ) – PRBS 7. 

- Fixed the issue of the CTLE Setting do not reported correctly if multiple jitter tests run together. 

- Fixed the issue of the incorrect note of insufficient waveform length for jitter related tests. 

- Fixed the issue of unit interval measurement of the AUX Channel Tests is incorrect for certain 

AUX Channel signal by gating the unit interval measurement on interested AUX Channel 

transaction only. 

- Fixed the issue of AUX Channel Eye Test and AUX Channel Peak to Peak Voltage Test unable to 

run if the Sampling Rate is set greater than 5GSa/s (default). 

- Fixed the issue of bandpass filter applied on AUX Channel Eye Test for all test specification. 

- Fixed the issue of the Connection Type is not loaded correctly when loading the project. 

- Fixed the issue of the DisplayPort application crashes if the DisplayPort Test Controller dialog is 

opened during the exit of the DisplayPort application. 

Note 

- When upgrading the Infiniium version to Infiniium 6.40 and above, please reinstall the 

DisplayPort application. 

- The user MUST manually download the VESA DP Eye Test tool from VESA website if they want 

to run the Eye Diagram Test (TP_RX_DFE) tests. 

Known Issue 

- The CTS numbering in the test name for DisplayPort 1.4a still based on the DisplayPort CTS 

1.2b. 

- The Result Append/Replace/Cancel message might not appear even user re-run the DisplayPort 

application with existing result. 

- User might experience the test result do not get replaced even user select “Replace” for the 

Result Append/Replace/Cancel message. 



 

 

Keysight D9040DPPC DisplayPort Compliance and Validation Test Application Release Notes 20 / 72 

 

 

o Please delete the test result manually first before re-run the test if the user wishes to 

“Replace” the existing test result. 

 

- User will experience error if running the Eye Diagram Test (TP_RX_DFE) with “Capture Mode” or 

“Analysis Mode”. 

o Please run the Eye Diagram Test (TP_RX_DFE) with “Standard Mode”. 

- User might experience the issue of unable to find the fifth harmonic when running the Level and 

Equalization Verification Testing with SSC enabled. 

o Please update the “FFT Peak Search Threshold” configuration variable under Debug 

mode to lower value so the peak search threshold level is between the peaks and the 

noise floor of the FFT signal. 

- User might experience the issue in exporting the test result in PDF format. 

o Please export the test result in HTML format. 
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Keysight U7232E Software Version 3.75 

 

Released Date: 20 February 2019 

Requirements category (e.g., operating system): Microsoft Windows 10, Microsoft Windows 7 

Requirements category (e.g., minimum instrument 

software version): 

10.00.04101 (UXR-Series) 

06.30.00701 (90000 Series, 90000 X-Series, 90000 Q- 

Series, V-Series, Z-Series) 

File Name: SetupInfDisplayPort03750000.exe 

 

New Features 

- Supports Infiniium Oscilloscope Software version 6.30 for Infiniium Offline. 

- Supports Infiniium Oscilloscope Software version 10.00 for UXR-Series oscilloscope. (Limited 

supports). Please refer to the Know Issue for more information. 

- Supports user configurable screenshot file format check via “Screenshot File Format” 

configuration variables. Please refer to Programmer’s Reference for more details (see Help > API 

Reference > Remote Interface). 

- Supports user configurable waveform interpolation for Eye Diagram Test, Eye Diagram Test 

(TP3_EQ), CTLE Calibration via "Interpolation (Eye Diagram)" configuration variables. Please 

refer to Programmer’s Reference for more details (see Help > API Reference > Remote 

Interface). 

Modification 

- Updated the mask file folder from “C:\Program 

Files\Keysight\Infiniium\Apps\DisplayPortTest\app\config\Masks” folder to 

“C:\ProgramData\Keysight\Infiniium\Apps\DisplayPortTest\app\Masks” folder. 

- Updated the test name for the CTLE Optimization from HBR2CPAT to TPS4. 

- Removed the “Source Test Offline Mode” configuration variables under Debug mode. 

- Removed the HBR2 from running the CTLE Optimization. 
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Bug Fixes 

- Fixed the issue of missing remote interface hint for the controls in the child dialog. 

- Fixed the no connection issue during the saving of scope image. 

o Fixed the issue of “Error Reading Binary data from TCPIP0:localhost:hislip0:INSTR” error 

during the saving of scope image. 

- Fixed the issue of “Capture And Analysis Mode” selection is not available for Test Tools in 

oscilloscope. 

- Fixed the issue power supply or load configuration message prompted during the run of the 

Analyze Mode for DPoC or DPoC 1.4 Test Specification. 

- Fixed the issue of SICL error when running the Analyze Mode for Eye Diagram Test (TP3_DFE) 

and Eye Diagram Test with No Cable Model (TP3_DFE). 

- Fixed the typo issue for the AUX Channel connection diagram. 

Known Issue 

- The “Analyze Mode: Analyze captured waveforms” do not works with Infiniium 10 (UXR- Series 

oscilloscope). Running the “Analyze Mode” with Infiniium 10 will causes both the Infiniium 

application and DisplayPort application crashes. 

o Please run the “Analyze Mode” with Infiniium offline version 6.30 as workaround solution. 

- The CTS numbering in the test name for DisplayPort 1.4a still based on the DisplayPort CTS 

1.2b. 

- User might experience the issue of unable to find the fifth harmonic when running the Level and 

Equalization Verification Testing with SSC enabled. Please update the “FFT Peak Search 

Threshold” configuration variable under Debug mode to lower value so the peak search 

threshold level is between the peaks and the noise floor of the FFT signal. 
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Keysight U7232E Software Version 3.73 

 

Released Date: 19 October 2018 

Requirements category (e.g., operating system): Microsoft Windows 10, Microsoft Windows 7 

Requirements category (e.g., minimum instrument 

software version): 

06.30.00609 (90000 Series, 90000 X-Series, 90000 Q- 

Series, V-Series, Z-Series) 

File Name: SetupInfDisplayPort03730000.exe 

 

New Features 

- Supports Infiniium Oscilloscope Software version 6.30. 

- Supports DisplayPort Standard, Version 1.4. 

 

Modification 

- Updated the pattern trigger to InfiniiScan Generic Serial Trigger from the Advanced 

Communication Trigger. 

- Updated the number of UI for Eye Diagram Test for DP 1.4a and above only become 2MUI. 

 

Bug Fixes 

- Fixed the issue of DisplayPort application unable to launch with error of unable access the 

Global.js file. 

- Fixed the issue of unable to load project file with “Last” trials Store Mode. 

- Fixed the issue of unable to set the DisplayPort Test Controller Script File value. 
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- Fixed the issue of incorrect mask loaded for the Eye Diagram Test (TP3_EQ) for HBR 

(Informative). 

 

Known Issue 

- The CTS numbering in the test name for DisplayPort 1.4a still based on the DisplayPort CTS 

1.2b. 

- User might experience the issue of unable to find the fifth harmonic when running the Level and 

Equalization Verification Testing with SSC enabled. Please update the “FFT Peak Search 

Threshold” configuration variable under Debug mode to lower value so the peak search 

threshold level is between the peaks and the noise floor of the FFT signal. 
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Keysight U7232E Software Version 3.71 

 

Released Date: 6 June 2018 

Requirements category (e.g., operating system): Microsoft Windows 10, Microsoft Windows 7 

Requirements category (e.g., minimum instrument 

software version): 

06.20.00801 (90000 Series, 90000 X-Series, 90000 Q- 

Series, V-Series, Z-Series) 

File Name: SetupInfDisplayPort03710000.exe 

 

New Features 

- Supports DisplayPort Standard, Version 1.4a. 

o Supports DisplayPort 1.4a PHY Compliance Test Specification. 

- Support DisplayPort Over USB Type-C based on DisplayPort 1.4a PHY CTS (DPoC 1.4a) Test 

Specification. 

- Supports user configurable test pattern check via “Pattern Check” configuration variables. 

Please refer to Programmer’s Reference for more details (see Help > API Reference > Remote 

Interface). 

 

Modification 

- Updated the default value for following settings: 

o Test Specification: 1.4a (from 1.2) if the required license installed. 

- Updated the Test Specification “1.4” to “1.4a” based on DisplayPort 1.4a PHY Compliance Test 

Specification. 
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- Updated the DisplayPort Application to check the “Test Setup” and “Connection Setup” 

status is completed before able to run the tests. 

o For the remote user, please set the “TestSetupComplete” and 

“ConnectionSetupComplete” configuration variable to “1.0” to update the status to 

completed. 

- Updated the Physical Layer Tests to default remove the DC Blocking Capacitor delay exists in 

the Rx Test Lanes (Lane 0 and Lane 3) for DPoC and DPoC 1.4a Test Specification. 

o By default, 118ps delay time will be removed for Lane 0 and Lane 3 based on the typical 

delay of N9398C DC Blocking Capacitor. 

o Supports user configurable DC Block delay time removal for all Physical Layer Tests via 

“Rx Test Lane DC Block Delay Time Removal” and “Rx Test Lane DC Block Delay Time 

(ps)” configuration variables. Please set the delay time based on the DC Blocking 

Capacitor used. Please refer to Programmer’s Reference for more details (see Help > 

API Reference > Remote Interface). 

- Report the voltage and the current of the power profile for DPoC and DPoC 1.4a Test 

Specification. 

- Updated the connection diagram of N7015A to include DC Blocking Capacitor on Rx Test Lane 

ONLY (Lane 0 and Lane 3) for DPoC and DPoC 1.4a Test Specification. 

- Updated the test name of the “Intra-Pair Skew Test” to “Intra-Pair Skew Test (Informative)”. 

- Updated the “Cable Model” report item to include actual cable model s-parameter file used. 

- The DisplayPort application will not preset the oscilloscope during the exists of the application. 

 

Bug Fixes 

- Fixed the issue of GUI slowness for the selection made on the Test Setup dialog or Connection 

Setup dialog. 

- Fixed the issue of automation issue for HBR3 testing in DPoC Test Specification. 

o Updated the DPCD revision of the DPoC Test Specification from DPCD 1.2 to DPCD 1.4 

to support HBR3. 
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- Fixed the issue of SICL error while setup InfiniiSim if the oscilloscope bandwidth is upgraded 

from 12GHz to 13GHz. 

- Fixed the issue of Arbitrary Pattern tests are not available if Data Pattern is set to Arbitrary 

Pattern. 

- Fixed the issue of the DFE is not enabled for the DPoC Test Specification 

- Fixed the issue of Link Training Mode is not selected for DisplayPort Test Controller dialog if the 

Link Training Mode is selected in Set Up tab. 

- Fixed the issue of the Arbitrary Pattern is not selected if Link Training Mode is selected. 

- Fixed the typo issue of the Eye Diagram Test (TP3_EQ) and Eye Diagram Test with No Cable 

Model (TP3_EQ) that include RBR and HBR in the Select Tests tab. 

- Fixed the issue of Total Jitter Test (TP3_EQ) and Total Jitter Test with No Cable Model (TP3_EQ) 

tests are not available for HBR as informative test. 

- Fixed the issue of incorrect limit loaded for Deterministic Jitter Test (TP3_EQ) – D10.2 and 

Random Jitter Test (TP3_EQ) – D10.2 for MyDP 1.0 and MyDP HBR25 Test Specification. 

- Fixed the issue during the Eye Diagram Test (TP3_DFE) if the user set the sampling rate to 80 

GSa/s. 

- Fixed the issue of incorrect screenshot loaded for the Pre-Emphasis Level Tests. 

- Fixed the issue of Post-Cursor 2 Verification Tests unable to run. 

- Fixed the issue or error thrown while running Sink Test with switch matrix enabled. 

- Fixed the issue of Dual Mode Test Eye Diagram Testing and Dual Mode Data Jitter tests unable 

to run. 

- Fixed the issue of incorrect label for the Single-Ended Connection of Dual Mode Tests. 

- Fixed the issue of application crashes when deleting test results. 

Note 

- Application’s project file saved for version 3.62 and below will be opened as read-only. 

- Application’s project file saved for version 3.70 and below will be opened as settings-only or 

read-only. 
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Known Issue 

- The CTS numbering in the test name for DisplayPort 1.4a still based on the DisplayPort CTS 

1.2b. 
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Keysight U7232E Software Version 3.70 

 

Released Date: 23 November 2017 

Requirements category (e.g., operating system): Microsoft Windows 10, Microsoft Windows 7 

Requirements category (e.g., minimum instrument 

software version): 

06.10.00709 (90000 Series, 90000 X-Series, 90000 Q- 

Series, V-Series, Z-Series) 

File Name: SetupInfDisplayPort03700000.exe 

 

New Features 

- Support DisplayPort Over USB Type-C (DPoC) Test Specification. 

- Support Keysight N7018A USB Type-C Test Controller automation. 

- Support DigitalTest Application Sequencer. 

- Supports user configurable filter for AUX Channel signal via “Filter” and “Filter Cutoff 

Frequency” configuration variables. Please refer to Programmer’s Reference for more details 

(see Help > API Reference > Remote Interface). 

- Test Time Reduction: 

o Supports user configurable screenshot for all tests except Eye Diagram Tests and Eye 

Diagram Tests (TP3_EQ) via “Screenshot” configuration variable. For Eye Diagram Tests 

and Eye Diagram Tests (TP3_EQ), the screenshot always enabled. For test time 

reduction, user can optionally disable the screenshot. Please refer to Programmer’s 

Reference for more details (see Help > API Reference > Remote Interface). 

o Supports user configurable vertical scale mode for all Physical Layer Tests via “Identical 

Vertical Scale Mode” configuration variable. For test time reduction, user can optionally 

select “Fixed” mode for vertical scale mode to use fixed value for vertical range and 

offset of the input signal without performing vertical range optimization. Please refer to 

Programmer’s Reference for more details (see Help > API Reference > Remote 

Interface). 
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o Support user selectable Link Training before the Test Automation Request for Unigraf 

DisplayPort Test Controller via the Device Configuration dialog. For test time reduction, 

user can optionally disable the Link Training before every Test Automation Request (Link 

Training only perform once on start of the test). 

 

Modification 

- Updated the clock recovery setting to include the bandwidth correction for OJTF. 

- Updated the cable model for HBR3 based on the DP HBR3 PHY Spec and CTS. 

o Standard DP: 

▪ HBR3: Source_100ohms_CIC.sp4 (from dec_plugtest_hbr3_cic.s4p) 

▪ HBR2, HBR, RBR: CIC_rev0p6.s4p 

 

o USB Type-C: 

▪ HBR3: Source_100ohms_CIC.sp4 (from dec_plugtest_hbr3_cic.s4p) 

▪ HBR2, HBR, RBR: c2dp_90ohms_0psSkew.s4p 

 

- Updated the Non-PreEmphasis Level Test, Pre-Emphasis Level Test and Non-Transition Voltage 

Range Measurement for HBR2 and HBR3 to informative for DisplayPort 1.4 Test Specification. 

- Updated the TP3_EQ tests to include the CTLE setting and DFE setting in the result statistic 

summary. 

- Updated the maximum limit for AUX Channel Peak to Peak Voltage to 1.38V for both Source 

and Sink in DisplayPort 1.4 Test Specification based on AUX Channel PHY SCR Version. 
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Bug Fixes 

- Fixed the issue of missing “Skip completed tests” in the Run Tests tab. 

- Fixed the issue of unable to configure the Connector Type remotely. 

- Fixed the issue of no CTS numbering for Lane 0/ Lane 3 - Inter Pair Skew Test (High Bit Rate 3) 

- PRBS 7. 

- Fixed the issue of clipped CTLE signal that causes the error in getting the EZJIT Completed 

RJDJ measurement result from the oscilloscope. 

- Updated the TP3_EQ tests to include the CTLE setting and DFE setting in the result statistic 

summary. 

- Fixed the issue of Intra Pair Skew Test do not filter off the intra pair skew measurement greater 

than one UI. 

- Fixed the issue of incorrect measurement for Inter Pair Skew Test with Switch Matrix enabled. 

- Fixed the error in deleting the waveform files when acquiring the waveform for the AUX Channel 

offline mode. 

- Fixed the issue of inconsistent AUX Channel Unit Interval measurement when there are spikes 

exists in the AUX Channel signal. 

 

Note 

- Application’s project file saved for version 3.62 and below will be opened as read-only. 
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Keysight U7232D Software Version 3.61 

 

Released Date: 27 March 2017 

Requirements category (e.g., operating system): Microsoft Windows 10, Microsoft Windows 7 

Requirements category (e.g., minimum instrument 

software version): 

6.00.00602 (90000 Series, 90000 X-Series, 90000 Q- 

Series, V-Series, Z-Series) 

File Name: SetupInfDisplayPort03610000.exe 

 

New Features 

- Supports Infiniium Oscilloscope Software version 6.00. 

- Supports Test Tools – CTLE Optimization. 

- Supports different Capture and Analysis Mode for Physical Layer Tests. 

o Standard Mode: 

▪ Capture and analyze live waveform. 

o Capture Mode: 

▪ Acquire and save waveforms only. 

▪ The waveforms will be saved in the following directory by using the Device ID as 

the folder name. If no Device ID is specified, the “Source” folder name will be 

used.  

C:\ProgramData\Keysight\Infiniium\Apps\DisplayPortTest\app\Waveform\ 

<Test Specification>\<Device ID> 
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o Analyze Mode: 

▪ Analyze saved waveforms. 

▪ User can specify the device to be analyzed based on the folders exists in the 

following directory. 

C:\ProgramData\Keysight\Infiniium\Apps\DisplayPortTest\app\Waveform\ 

<Test Specification> 

 

Modification 

- Updated the cable model for HBR3 based on the DP HBR3 PHY Spec and CTS. 

- Updated the CTLE settings for HBR3 based on the DP HBR3 PHY Spec and CTS which will be 

similar to Thunderbolt 3 and USB3.1 Gen2: 

o Adc: -9dB to 0 dB,10 curves (Need to perform CTLE Optimization to find the optimal Adc 

based on Eye Height) 

o Aac: 3.5 dB 

o Pole 1 Frequency: 3.03 GHz 

o Pole 2 Frequency: 5.60 GHz 

- Updated the maximum limit for AUX Channel Peak to Peak Voltage to 1.38V for Source in 

DisplayPort 1.4 Test Specification. 

 

Bug Fixes 

- Fixed the issue of Set Up tab greyed out when running the internal command automation. 

- Fixed the issue of error in performing waveform acquisition for the Capture Mode when Channel 

1 is not selected for any test lane. 
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- Fixed the issue of result discrepancy between Standard Mode and Analyze Mode for Eye 

Diagram Tests (TP3_EQ). 

- Fixed the OutOfMemoryException error issue during the run of the test or export the HTML 

results. 

- Fixed the issue of report items error thrown while running the Eye Diagram Tests (TP3_EQ) for 

HBR2 and HBR25 in MyDP HBR25 Test Specification. 

- Fixed the issue of error in scaling waveform to fit screen for Sink or Cable device. 

- Fixed the issue of AUX Channel Tests and Dual Mode Tests unable to run. 
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Keysight U7232D Software Version 3.52.0001 

 

Released Date: 8 December 2016 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., minimum instrument 

software version): 

5.70.00901 (90000 Series, 90000 X-Series, 90000 Q- 

Series, V-Series, Z-Series) 

File Name: SetupInfDisplayPort03520001.exe 

 

Bug Fixes 

- Fixed the issue of AUX Channel Tests and Dual Mode Tests unable to run. 

 

Keysight U7232D Software Version 3.52 

 

Released Date: 25 November 2016 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., minimum instrument 

software version): 

5.70.00901 (90000 Series, 90000 X-Series, 90000 Q- 

Series, V-Series, Z-Series) 

File Name: SetupInfDisplayPort03520000.exe 

 

New Features 

- Supports custom fixture de-embedding. To use the fixture de-embedding: 

o Copy the s-parameter file to the "Other" folder in the following directory and rename the 

file to "Other.s2p" or "Other.s4p". 

C:\ProgramData\Keysight\Infiniium\Apps\DisplayPortTest\app\S- 

Parameter\Fixture\Other 
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- Restart the DisplayPort application. 

- The "Other" fixture type will allow user to de-embed fixture now. 

- Note: 

▪ All the s-parameter files in the "Other" folder will be used for de-embedding of 

the "Other" fixture type. 

▪ Every time a different s-parameter is used, please delete all the transfer function 

file where the name contains "Other" in the following directory to force the 

DisplayPort application to regenerate the transfer function: 

C:\ProgramData\Keysight\Infiniium\Apps\DisplayPortTest\app\Transfer 

Function 

- Supports user configurable AUX Channel idle DC offset removal for AUX Channel Tests via “AUX 

Idle DC Offset” configuration variable under debug mode. The DisplayPort application will 

remove the DC offset using the offset of the input channel’s external scaling. Please refer to 

Programmer’s Reference for more details (see Help > Remote Interface). 

 

Modification 

- Updated the DisplayPort application based on the HBR3 Jitter Budget SCR: 

o Updated the Non ISI Jitter Test (TP3_EQ) limit for HBR3 from 0.56 UI to 0.41 UI. 

o Updated the HBR3 Reference Equalizer: 

▪ Zero location from 0.505 to 0.640 

▪ Pole 1 location from 3.033 to 4.050 

▪ Pole 2 location from 6.000 to 10.000 

 

- Updated the fixture name “Wilder Tech DP-TPA-P/ BIT-DP-PTF-0003/ Tek TF-DP-TPA-P” to 

“Wilder Tech DP-TPA-P/ BIT-DP-PTF-0003”. 

- Updated the test name in HTML report to include the DisplayPort CTS numbering. 
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- Updated the behavior of DFE’s feedback coefficient will automatic limit to 50mV if the 

optimized feedback coefficient is greater than 50mV for compliance mode. Under debug mode, 

user can select whether to set the DFE’s feedback coefficient to 50mV or optimized feedback 

coefficient if the optimized feedback coefficient is greater than 50mV. 

- Updated the Eye Diagram Test (TP3_EQ) for HBR2 and HBR3 to support “Normalized” and 

“Relative” for the “Eye Mask Scale” configuration variable. 

- Added the transition bit screenshot for the Pre-Emphasis Level Tests. 

- Removed the AUX Channel idle DC offset by default for AUX Channel Tests. 

 

Bug Fixes 

- Fixed the error in scaling the waveform to fit the screen with single-ended connection. 

- Fixed the issue of “Error in Executing Infiniium Command” during the saving of the setup file at 

the start of the tests due to the limited access to the Program Files. 

- Fixed the issue of incorrect pattern check for TPS4 by update the search pattern from 

“0010111100010111110010100000110010111100” to 

“0011110100001111101011000001010011110100”. 

- Fixed the issue of eye mask shifted to the left of the eye diagram due to no valid eye opening on 

the left side of the eye diagram to find the zero UI timbase reference. 

- Fixed the issue of unable to run TP3_EQ tests with CTLE disabled. 

- Fixed the append results issue for Eye Diagram Test (TP3_EQ) where the Eye Diagram Test 

(TP3_EQ) do not appear in the existing results test list. 

- Fixed the issue of DFE is enabled for RBR and HBR for Eye Diagram Test (TP3_EQ). 

- Fixed the issue of incorrect histogram placement for VHigh non-transition voltage measurement 

of PRBS 7. 

- Fixed the issue of no SSC signal available for SSC Modulation Frequency Test. 

- Fixed the issue of error in acquiring waveform for Intra Pair Skew Tests when the single- ended 

signal has DC offset. 
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- Fixed the issue of error thrown when running the AUX Channel Trigger Setup Verification with 

Single-Ended connection. 

- Fixed the issue of Trigger Setup failed for AUX Channel single-ended signal that goes LOW only. 

- Fixed the issue of amplitude validation for Dual Mode Tests where the measured Vpp return 

invalid result. 
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Keysight U7232D Software Version 3.51.0001 

 

Released Date: 19 July 2016 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., minimum instrument 

software version): 

5.60.00602 (90000 Series, 90000 X-Series, 90000 Q- 

Series, V-Series, Z-Series) 

File Name: SetupInfDisplayPort03510001.exe 

 

Bug Fixes 

- Fixed the issue of Inter Pair Skew Test unable to run with Arbitrary Pattern. 

 

Keysight U7232D Software Version 3.51 

 

Released Date: 17 June 2016 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., minimum instrument 

software version): 

5.60.00602 (90000 Series, 90000 X-Series, 90000 Q- 

Series, V-Series, Z-Series) 

File Name: SetupInfDisplayPort03510000.exe 

 

New Features 

- Supports DisplayPort Standard, Version 1.4. 

- Supports USB Type-C to DisplayPort cable model when Keysight N7015A fixture is selected. 
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Modification 

- Updated the “Exclude Random Jitter and Noise Derate (TP3_EQ)” configuration variable default 

value from “False” to “True” as recommendation from VESA Interoperability to not include the 

random jitter and random noise expansion of the mask. 

- Updated the test pattern for TP3_EQ tests from HBR2CPAT to TPS4. 

- Updated the jitter tests for the HBR3 from Deterministic Jitter Test (TP3_EQ) to Non ISI Jitter 

Test (TP3_EQ). 

- Updated the report item “Cable Embedding” to “Cable Model” in all TP3_EQ test point related 

tests. 

- Added the report item “CTLE Setting” and “DFE Setting” in all TP3_EQ test point related tests. 

 

Bug Fixes 

- Fixed the issue of unable to run the DisplayPort application with the DisplayPort 1.3 standalone 

license. 

- Fixed the issue of TP3_EQ tests unable to run with the single-ended connection without fixture 

de-embedding. 

- Fixed the issue of SICL error when running the Main Link Frequency Compliance test. 

- Fixed the issue of permutation not available for Lane 3 - AC Common Mode Test for 8.1 Gbps. 

- Fixed the error in scaling the waveform to fit the screen with single-ended connection. 

- Fixed the issue of report items error thrown while running the Eye Diagram Tests (TP3_EQ) for 

HBR2 and HBR25 in MyDP HBR25 Test Specification. 

- Fixed the issue of real time eye error in Dual Mode TMDS Clock Duty Cycle tests. 

- Fixed the issue of real time eye is not placed at the center of the screens for the Dual Mode Eye 

Diagram Testing. 

- Fixed the issue of error in conversion of the report image file and the report image misaligned. 

- Fixed the intermittent issue of unable to perform AUX Channel trigger setup for single- ended 

connection. 
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Keysight U7232D Software Version 3.50.0001 

 

Released Date: 5 May 2016 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., minimum instrument 

software version): 

5.52.0004 (90000 Series, 90000 X-Series, 90000 Q- 

Series, V-Series, Z-Series) 

File Name: SetupInfDisplayPort03500001.exe 
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Modification 

- Update the Keysight U7232D DisplayPort Electrical Performance Compliance Test Application’s 

Method of Implementation (MOI) document. 
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Keysight U7232D Software Version 3.50 

 

Released Date: 22 January 2016 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., minimum instrument 

software version): 

5.52.0004 (90000 Series, 90000 X-Series, 90000 Q- 

Series, V-Series, Z-Series) 

File Name: SetupInfDisplayPort03500000.exe 

 

New Features 

- Supports DisplayPort Standard, Version 1.3. 

- Supports Link Training Mode and Arbitrary Pattern for DisplayPort 1.3. 

- Supports E2677A Differential Solder-In probe head for AUX Channel Tests with Reference 

Device. 

- Supports user configurable probe head check for Physical Layer Tests via “Probe Check 

(Physical Layer Tests)” configuration variable under debug mode. Please refer to Programmer’s 

Reference for more details (see Help > Remote Interface). 

 

Modification 

- Removed the DisplayPort 1.1, DisplayPort 1.1a, eDP 1.3 from the Test Specification selection. 

Default the Test Specification to DisplayPort 1.2b. 

- Removed the KeysightW2642A test controller from the DisplayPort Test Controller selection. 

- Removed the Keysight W2641A fixture from the Fixture Type selection. 

- Added the “Keysight N7015A” in the Fixture Type selection. 

- Renamed the “ICT Lanto mDP Plug” in the Fixture Type selection to “Luxshare ICT mDP 

Plug”. 

- Added the screenshot for the Peak to Peak Voltage Test. 
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Bug Fixes 

- Fixed the issue of no status respond for the configuration of the DisplayPort Test Controller. 

- Fixed the issue of fixture de-embeded for TP3_EQ tests even the De-Embed Fixture is not 

enabled. 

- Fixed the issue of incorrect report field for the screenshot name of Cable Eye Diagram Test. 

- Fixed the issue of incorrect connection diagram loaded for the AUX Channel Calibration Tests 

and AUX Channel Sensitivity Tests for MyDP 1.0 and MyDP HBR25. 

- Fixed the issue of unable to acquire signal for Dual Mode Eye Diagram Testing and Dual Mode 

Jitter Test. 

 

Note 

- Keysight recommends running the DisplayPort application with Infiniium user interface 

disabled. Please refer to Online Help for more details (see Help > Contents… > Running Tests > 

To Set the Run Preferences). 

- Keysight recommends the user to remains active for the same session of Remote Desktop on 

the same machine if Remote Desktop is required. 

- Keysight recommends viewing the DisplayPort application’s html report with Internet Explorer. 
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Keysight U7232C Software Version 3.42 

 

Released Date: 11 December 2015 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., minimum instrument 

software version): 

5.50.0033 (90000 Series, 90000 X-Series, 90000 Q- 

Series, V-Series, Z-Series) 

File Name: SetupInfDisplayPort03420001.exe 

 

New Features 

- Supports Infiniium Oscilloscope Software version 5.50. 

- Supports Infiniium Oscilloscope Software version 5.50 for V-Series oscilloscope. 

- Supports Infiniium user interface disabled feature during the run of the test. Please refer to 

Online Help for more details (see Help > Contents… > Running Tests > To Set the Run 

Preferences). 

 

Modification 

- Updated the eye mask from fixed mask to dynamic generated mask for the Eye Diagram Test 

(TP3_EQ) in MyDP HBR25 Test Specification. 

- Updated the eye mask for the Eye Diagram Test (TP3_EQ) as below for DP 1.2b, MyDP 1.0 and 

MyDP HBR25 Test Specification: 

 

 

 

5.4 Gbps: 

- If DUT has 1 lane, start eye mask with 90 mV by 0.38 UI (do not include crosstalk derating) 

- If DUT has 2 lanes or 4 lanes, start eye mask with 104 mV by 0.42 UI (include crosstalk derating of 

14 mV and 0.04 UI) 

6.75 Gbps: 

- If DUT has 1 lane, start eye mask with 110 mV by 0.4185 UI (do not include crosstalk derating) 

- If DUT has 2 lanes or 4 lanes, start eye mask with 124 mV by 0.4585 UI (include crosstalk derating 

of 14 mV and 0.04 UI) 
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- Improve the robustness of the random noise measurement using Histogram method in Eye 

Diagram Test (TP3_EQ) by folding the equalized signal using serial pattern search UDF on the 

equalized signal instead of InfiniiScan Generic Pattern trigger on the input channel signal. 

- Updated the limit for the Aux Channel Peak to Peak Voltage Test by adding upper limit of 

1.38V base on the DisplayPort specification. 

- Report the “Cable Embedding” configuration variable in all TP3_EQ test point related tests. 

 

Bug Fixes 

- Fixed the issue of display SICL command error when running the DisplayPort application with 

Infiniium 4.60 or below. 

- Fixed the issue of InfiniiSim function error when running the DisplayPort application without the 

InfiniiSim license installed in the Infiniium. 

- Fixed the issue of Test Setup status do not update and test do not selected when load the 

settings from the project. 

- Fixed the issue of DisplayPort Test Controller dialog crashes after minimize and maximize the 

dialog window. 

- Fixed the issue of DisplayPort application crashes if EDID file not found. 

- Fixed the issue of no suppression response error when SuppressMessages is set to true. 

- Fixed the issue of incorrect connection diagram in the Connection Diagram dialog for the Switch 

Matrix Settings. 

- Fixed the issue of error thrown when creating a new project for eDP 1.3 Test Specification. 

- Fixed the issue of application crashes when selecting the Sink or Cable device for eDP 1.3 Test 

Specification. 

- Fixed the issue of incorrect vertical waveform scaling with differential connection and fixture de-

embed. 

- Fixed the issue of “Measurement took too long" error shown during the test run. 

- Fixed the issue of serial pattern search do not work properly if the pre-emphasis level is too 

high. 



47 / 72  Keysight D9040DPPC DisplayPort Compliance and Validation Test Application Release Notes 

 

 

- Fixed the issue of incorrect histogram placement if the “Serial Pattern Eye Method (Voltage 

- Level)” configuration variable is set to “2”. 

- Fixed the issue of mask file access problem for the Eye Diagram Test (TP3_EQ). 

- Fixed the issue of incorrect default number of UI for Eye Diagram Test by changing the default 

number of UI from 256,000 UI to 1,000,000 UI. 

- Fixed the issue of incorrect value reported for Non Transition Voltage Range Measurement (Non 

minimum value reported for the test). 

- Fixed the issue of incorrect screenshot for the Pre-Emphasis Level Delta Test. 

- Fixed the issue of histogram window out of the screen for Post-Cursor 2 Verification Test. 

- Fixed the issue of the Intra Pair Skew Test. 

o Update the Intra Pair Skew Test Equation from 

Intra Pair Skew = 1/NumEdges * Sum[|(D+_High – D-_Low) + (D+_Low – D-_High)|]/2 to 

Intra Pair Skew = 1/NumEdges * Sum[(D+_High – D-_Low) + (D+_Low – D-_High)]/2 

o Update the Intra Pair Skew Test to exclude the intra pair skew measurement that is 

greater than one UI. 

- Fixed the issue of the Intra Pair Skew Test unable to run for multiple trials. 

- Fixed the issue of AUX Channel Trigger Setup is not working without the EZJIT or EZJIT Plus 

license. 

- Fixed the issue of AUX Calibration Test and AUX Channel Sensitivity Test unable to run with 

single-ended connection. 

- Fixed the issue of inconsistent trigger for AUX Channel Eye Test and AUX Channel Peak to Peak 

Voltage Test. 

- Fixed the issue of small eye diagram screenshot for AUX Channel Eye Test, AUX Channel Peak 

to Peak Voltage Test, AUX Channel Eye Sensitivity Calibration. 

- Fixed the issue of error in loading the mask file for AUX Channel Eye Test for MyDP HBR25 Test 

Specification. 

- Fixed the issue of Peak to Peak Voltage Test status didn’t update to complete after all the test 

trials completed. 
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Agilent U7232C Software Version 3.41 

 

Released Date: 16 April 2015 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 4.60 (90000 Series, 90000 X-Series, 90000 Q-Series, Z- 

Series) 

File Name: SetupInfDisplayPort03410000.exe 

 

New Features 

- Supports Infiniium Oscilloscope Software version 5.50. 

- Supports user configurable random jitter and removal of the oscilloscope’s calibrated random 

jitter from the reported RJ in jitter tests via “Jitter RJ Mode” configuration variable under debug 

mode. Please refer to Programmer’s Reference for more details (see Help > Remote Interface). 

- Supports user configurable random noise measurement in Eye Diagram (TP3_EQ) tests for eDP 

via “Random Noise Measurement Method” configuration variable. Please refer to Programmer’s 

Reference for more details (see Help > Remote Interface). 

- Supports Dual-mode Peak-Peak Differential Voltage, Dual-mode Inter Pair Skew and Dual-

mode Intra-Pair Skew tests. 

- Supports Wilder Technologies DP-TPA-P connection diagram for Aux Channel Tests and Aux 

Channel Sensitivity Test. 

Modification 

- Minimum Infiniium Oscilloscope Software updated to version 4.60. 

- Improved project saving, project loading and result manipulation time. 

- Removed the upper limit and lower limit of the eye mask in Eye Diagram tests. 

- Improve the robustness of the random noise measurement using Histogram method in Eye 

Diagram (TP3_EQ) tests. 

 



49 / 72  Keysight D9040DPPC DisplayPort Compliance and Validation Test Application Release Notes 

 

 

Bug Fixes 

- Fixed the issue of missing msvcr71.dll when enable the Unigraf DisplayPort Test Controller. 

- Fixed the issue of acquisition bandwidth reduction that causes error in the application. 

- Fixed the issue of incorrect CDR setting loaded for the Serial Data folding in voltage level 

measurement. 

- Fixed the issue of small eye diagram screenshot in Eye Diagram and Eye Diagram (TP3_EQ) 

tests. 

- Fixed the issue of duplicate screenshot in Pre-Emphasis Level tests. 

- Fixed the issue of random jitter reported value from rms value to peak to peak value at BER9 for 

D10.2 Random Jitter (TP3_EQ) and D10.2 Random Jitter with No Cable (TP3_EQ) tests. 

- Fixed the issue of incorrect CDR setting loaded for the InfiniiScan folding for the random noise 

measurement for the HBR2CPAT Eye Diagram (TP3_EQ) tests. 

- Fixed the issue of GPIB command error for HBR2CPAT Eye Diagram (TP3_EQ) tests in MyDP 

HBR25. 

- Fixed the issue of error in scaling waveform for Intra-Pair Skew Test. 

- Fixed the issue of running the Dual Mode Tests in Infiniium 5.00 and above. 

- Fixed the issue of unable to run the 6.75 Gbps together with other Bit Rate in MyDP HBR25. 

- Fixed the issue of Fall Time test appears in MyDP HBR25. 

- Fixed the issue of switch matrix is not set correctly. 

- Fixed the issue of missing jitter plots in the report screenshot for jitter measurement in Infiniium 

5.00 and above. 

- Fixed the issue of no full screen jitter plot displayed in the jitter measurement in Infiniium 

5.00 and above. 

- Fixed the issue of InfiniiSim window displayed in the report screenshot in Infiniium 5.00 and 

above. 

- Fixed the issue of configuration variable is set correctly using Agilent Remote Scripting 

Language (ARSL). 
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- Fixed the issue of inconsistency in the vertical scale of the signal for the same differential 

voltage level. 

 

Agilent U7232C Software Version 3.40 

 

Released Date: 2 June 2014 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 4.50 (90000 Series, 90000 X-Series, 90000 Q-Series, Z- Series) 

File Name: SetupInfDisplayPort03400000.exe 

 

New Features 

- Supports Infiniium Oscilloscope Software version 5.00. 

- Supports Infiniium Oscilloscope Software version 4.50 for 90000 Z-Series oscilloscope. 

- New Help > Support > Collect Files menu item simplifies collecting files needed by Agilent 

support engineers. 

 

Modification 

- Minimum Infiniium Oscilloscope Software updated to version 4.50. 

- Updated the serial pattern search to Infiniium Serial Data folding for voltage level measurement. 

- When using BitifEye BIT2100 instrument for switch matrix, now requires minimum firmware 

version: 3.4-1.10. 

- Switch Matrix: In manual mode, you can now assign a scope channel to any switch's output, 

even if that switch does not have enough inputs for all of the test points that use that scope 

channel. 
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Agilent U7232B Software Version 3.32 

 

Released Date: 23 May 2014 

Requirements category (e.g., operating system): Microsoft Windows XP 

Microsoft Windows 7 

Requirements category (e.g., instrument software version): 4.20.0005 (Microsoft Windows XP for 90000 Series, 90000 X-

Series, 90000 Q-Series), 

4.50.0000 (Microsoft Windows 7 for 90000 Series, 90000 

X-Series, 90000 Q-Series) 

File Name: SetupInfDisplayPort03320000.exe 

 

New Features 

- Supports Infiniium Oscilloscope Software version 4.50.0000 for 90000 Q-Series oscilloscope. 

- Supports Mobility DisplayPort (MyDP) Compliance Test Specification (MyDP HBR25). 

- Support Device ID, Operator ID, Project ID and Comments fields for Dual Mode Tests setup. 

Modification 

- InfiniiSim now includes new Delay option. 

- InfiniiSim now includes new Normalize Gain option. 

- New option to control jump behavior when you double-click a test name on the Select Tests 

tab. See View > Preferences > Report. 

- Remote Interface updated to version 2.50. For more information, see Agilent’s N5452A Remote 

Programming Toolkit (www.agilent.com/find/scope-apps). 

http://www.agilent.com/find/scope-apps
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Bug Fixes 

- Fixed the issue of missing Physical Layer tests. 

- Fixed the issue of incorrect test limit for Dual Mode Data Jitter test by updating the limit from 

120ps to 150ps. 

- Fixed Connection tab "Suppress" checkbox. 

 

Miscellaneous Notes 

- This will be the last version to support Infiniium Oscilloscope Software Version 4.20. 
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Agilent U7232B Software Version 3.31 

 

Released Date: 6 August 2013 

Requirements category (e.g., operating system): Microsoft Windows XP 

Microsoft Windows 7 

Requirements category (e.g., instrument software version): 4.20.0005 (Microsoft Windows XP for 90000 Series, 90000 X-

Series), 

4.50.0000 (Microsoft Windows 7 for 90000 Series, 90000 X-

Series) 

File Name: SetupInfDisplayPort03310000.exe 

 

New Features 

- Supports for Infiniium Oscilloscope Software version 4.50.0000 for 90000 MSOX-Series 

oscilloscope. 

- Supports Mobility DisplayPort (MyDP) Compliance Test Specification Version 1.0 (MyDP 1.0). 
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Agilent U7232B Software Version 3.30 

 

Released Date: 17 May 2013 

Requirements category (e.g., operating system): Microsoft Windows XP 

Microsoft Windows 7 

Requirements category (e.g., instrument software version): 4.20.0005 (Microsoft Windows XP for 90000 Series, 90000 X-

Series), 

4.50.0000 (Microsoft Windows 7 for 90000 Series, 90000 

X-Series) 

File Name: SetupInfDisplayPort03300000.exe 
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New Features 

- Supports Mobility DisplayPort (MyDP) Compliance Test Specification Version 1.0 (MyDP 1.0) 

(unofficial). 

- Supports switch matrix. 

- Supports single-ended connection for AUX channels tests. 

 

Modification 

- Minimum Infiniium Oscilloscope Software updated to version 4.20.0005 for Window XP 

oscilloscope. 

- Minimum Infiniium Oscilloscope Software updated to version 4.50.0000 for Window 7 

oscilloscope. 

- Updated Dual Mode Tests to meet the DisplayPort PHY Compliance Test Specification, Version 

1.2b. 
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Agilent U7232B Software Version 3.21 

 

Released Date: 23 November 2012 

Requirements category (e.g., operating system): Microsoft Windows XP Microsoft Windows 7 

Requirements category (e.g., instrument software version): 3.59.0000 (90000 Series, 90000 X-Series) 

File Name: SetupInfDisplayPort03210000.exe 

 

New Features 

- Supports DisplayPort Standard, Version 1, Revision 2a and DisplayPort PHY Compliance Test 

Specification, Version 1.2b (DP 1.2b). 

- Supports Embedded DisplayPort Source PHY Compliance Test Guide, Version 1.0 (eDP 1.3). 

- Support Post-Cursor 2 options in the DUT Definition Setting. 

- Supports Peak to Peak Voltage Tests. 

- Supports HBR2 Eye Diagram Test with No Cable. 

- Supports Dual Mode Tests. 
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- Supports custom EDID file for both Agilent W2642A and Unigraf DPR-100 AUX controller for 

automation. 

 

Modification 

- Minimum Infiniium Oscilloscope Software updated to version 3.59.0000. 

- Application’s project file saved for version 3.11 and below will be opened as read-only. 

- Updated DisplayPort PHY Compliance Test Specification, Version 1.2 to DisplayPort PHY 

Compliance Test Specification, Version 1.2b. 

- Removed Link Layer Phy Change Tests. 

- Updated Post-Cursor 2 Tests as informative tests. 

- Updated the default Continuous Time Linear Equalizer (CTLE) values. 

 

Miscellaneous Notes 

- Addition Post-Cursor 2 selections may impact the configuration variable option in 

“PreferredLevelPreEmphasis” and “PreferredNoCableLevelPreEmphasis” in Remote 

Programming Interface. 
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Agilent U7232B Software Version 3.11 

 

Released Date: 18 November 2011 

Requirements category (e.g., operating system): Microsoft Windows XP 

Microsoft Windows 7 

Requirements category (e.g., instrument software version): 5.71.0000 (80000 Series), 

3.03.0002 (90000 Series, 90000 X-Series) 

File Name: SetupInfDisplayPort03110000.exe 

 

New Features 

- Supports Unigraf DPR-100 AUX controller with Reference Device for automation. 

 

Bug Fixes 

- Fixed the issue of DisplayPort application crashes when running sink tests. 
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Miscellaneous Notes 

- This will be the last version to support 80000 Series oscilloscope. 

 

Agilent U7232B Software Version 3.10 

 

Released Date: 5 October 2011 

Requirements category (e.g., operating system): Microsoft Windows XP 

Microsoft Windows 7 

Requirements category (e.g., instrument software version): 5.71.0000 (80000 Series), 

3.03.0002 (90000 Series, 90000 X-Series) 

File Name: SetupInfDisplayPort03100001.exe 

 

New Features 

- Supports for Window 7 Infiniium oscilloscope. 

- Supports automation controller for DP 1.2 device under test (DUT). 

 

Modification 

- Changed the test pattern name from CPAT2600 to HBR2CPAT. 

 

Bug Fixes 

- Fixed the issue of incorrect mask generation for HBR2 Eye Diagram Test. 
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Agilent U7232B Software Version 3.00 

 

Released Date: 27 April 2011 

Requirements category (e.g., operating system): Microsoft Windows XP 

Requirements category (e.g., instrument software version): 5.71.0000 (80000 Series), 

3.03.0002 (90000 Series, 90000 X-Series) 

File Name: SetupInfDisplayPort03000000.exe 

 

New Features 

- Supports DisplayPort Standard, Version 1, Revision 2 and DisplayPort PHY Compliance Test 

Specification, Version 1.2 (DP 1.2). 

- Supports HBR2 bit rate for compliance tests. 

- Supports fixture de-embedding for both Agilent fixtures and Wilder Technologies fixtures. 

- Supports Agilent W2642A AUX controller for automation. 

Modification 

- Minimum Infiniium Oscilloscope Software updated to version 3.03.0002 for 90000 Series and 

90000 X-Series oscilloscope. 

- Updated the GUI to simplify test configuration. 
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Agilent U7232A Software Version 2.11 

 

Released Date: 29 October 2010 

Requirements category (e.g., operating system): Microsoft Windows XP 

Requirements category (e.g., instrument software version): 5.71.0000 (80000 Series), 

2.10.0000 (90000 Series), 

3.00.0000 (90000 X-Series) 

File Name: SetupInfDisplayPort02110000.exe 

 

New Features 

- Supports DisplayPort Standard, Version 1, Revision 1a and DisplayPort PHY Compliance Test 

Specification, Version 1.1a (DP 1.1a). 

- Supports AUX Channel Eye Sensitivity Test to cover test 8.2 of DisplayPort PHY Compliance 

Test Specification, Version 1.1a (DP 1.1a). 

 

Modification 

- Updated the connection diagrams for AUX Channel Eye Sensitivity Calibration tests. 

- Renamed the name for AUX Channel Eye Sensitivity Calibration Test (Source) to AUX Channel 

Eye Sensitivity Calibration (Reference Sink). 

- Renamed the name for AUX Channel Eye Sensitivity Calibration Test (Sink) to AUX Channel Eye 

Sensitivity Calibration (Reference Source). 

- Improved the AUX Channel clock recovery method to handle noisy AUX Channel signal. 

- Addition 500Mz low pass filter is applied for the Vd signal before performing the power and 

current measurement in Inrush Energy Power Test and Inrush Peak Current Test. 
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Bug Fixes 

- Fixed the issue of incorrect report results format in Non-Transition Voltage Range Measurement 

Test by change the results format from range value to ratio value. 
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Agilent U7232A Software Version 2.10 

 

Released Date: 13 October 2010 

Requirements category (e.g., operating system): Microsoft Windows XP 

Requirements category (e.g., instrument software version): 5.71.0000 (80000 Series), 

2.10.0000 (90000 Series), 

3.00.0000 (90000 X-Series) 

File Name: SetupInfDisplayPort02100000.exe 

 

New Features 

- Supports Infiniium Oscilloscope Software version 3.00 for 90000 X-Series oscilloscope. 

- Supports AUX Channel tests and Inrush tests in AUX PHY and Inrush Tests. 

- Supports fixture de-embedding for oscilloscope with InfiniiSim option installed. 

- Supports user configurable SSC filter for the SSC tests via “SSC Filter Type” configuration 

variable that contains “Smoothing Filter” and “Butterworth Second Order” filter options. 

“Butterworth Second Order” filter will be the default filter for SSC tests. Please refer to 

Programmer’s Reference for more details (see Help > Remote Interface). 

Modification 

- Minimum Infiniium Oscilloscope Software updated to version 5.71.0000 for 80000 Series 

oscilloscope. 

- Minimum Infiniium Oscilloscope Software updated to version 2.10.0000 for 90000 Series 

oscilloscope. 

- Updated the AC Common Mode Test from normative tests to informative tests. 

- Updated the Non-Transition Voltage Range Measurement tests from informative tests to 

normative tests. 

- Updated the test limit for the Non-ISI Jitter Test from 0.17 UI to 0.21 UI. 

- Updated the test pattern for the Intra Pair Skew Test from PRBS 7 to D10.2. 
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- Reduced the resolution of the screenshot image to 8 bits to decrease the memory usage during 

report loading. 

 

Bug Fixes 

- Fixed the issue of incorrect results in Pre-Emphasis Level Test as the results of non SSC Pre-

Emphasis Level Test are being copied to the results SSC Pre-Emphasis Level Test if “Both” SSC 

option is selected. 
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Agilent U7232A Software Version 2.01 

 

Released Date: 10 April 2009 

Requirements category (e.g., operating system): Microsoft Windows XP 

Requirements category (e.g., instrument software version): 5.60.0000 (80000 Series), 

1.31.0000 (90000 Series) 

File Name: SetupInfDisplayPort02010000.exe 

 

Modification 

- Improved the Intra Pair Skew Test measurement method to cater for the rise fall mismatch 

signal. 

 

Bug Fixes 

- Fixed the issue of loading saved project as read-only file. 
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Agilent U7232A Software Version 2.00 

 

Released Date: 15 December 2008 

Requirements category (e.g., operating system): Microsoft Windows XP 

Requirements category (e.g., instrument software version): 5.60.0000 (80000 Series), 

1.31.0000 (90000 Series) 

File Name: SetupInfDisplayPort02000000.exe 

 

New Features 

- Supports DisplayPort Standard, Version 1.1 and DisplayPort PHY Compliance Test Standard, 

Version 1.1 (DP 1.1). 

- Supports Overshoot Test to cover test 3.8 of DisplayPort PHY Compliance Test Standard (DP 

1.1). 

- Supports SSC Deviation HF Variation Test to cover test 3.17 of DisplayPort PHY Compliance 

Test Standard (DP 1.1). 

- Supports skew calibration in Skew Calibration Page of the Setup Wizard. 

- Supports Agilent W2642A AUX controller for automation. 

Modification 

- Minimum Infiniium Oscilloscope Software updated to version 5.60.0000 for 80000 Series 

oscilloscope. 

- Minimum Infiniium Oscilloscope Software updated to version 1.31.0000 for 90000 Series 

oscilloscope. 

- Application’s project file saved for version 1.60 and below will be opened as read-only. 

- Updated the test methodology base on DisplayPort PHY Compliance Test Standard, Version 1.1. 

- Updated the test matrix base on DisplayPort PHY Compliance Test Standard, Version 1.1. 

- Removed Frequency Accuracy Tests base on DisplayPort PHY Compliance Test Standard, 

Version 1.1. 
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- Updated the test name from Frequency Long Term Stability Test to Main Link Frequency Test 

base on DisplayPort PHY Compliance Test Standard, Version 1.1. 

- Updated the user interface of the Setup Wizard by reducing the number of pages. 

- Updated the clock recovery bandwidth for Reduced Bit Rate (RBR) to 10.8 MHz for D10.2 test 

pattern and 5.4 MHz for PRBS 7 test pattern. 

- Updated the clock recovery bandwidth for High Bit Rate (HBR) to 20 MHz for D10.2 test pattern 

and 10 MHz for PRBS 7 test pattern. 

 

Miscellaneous Notes 

- Remote API is not backward compatible. 

- Application may slow down if the project file is large. 

- Automation is not fully supported for all devices. Supporting devices are subjected to test 

sequence referred in Appendix A: DisplayPort Source Automated Test with W2642A DPTC. 
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Agilent U7232A Software Version 1.60 

 

Released Date: 11 January 2008 

Requirements category (e.g., operating system): Microsoft Windows XP 

Requirements category (e.g., minimum instrument 

software version): 

5.40 (80000 Series), 

1.00.0000 (90000 Series) 

File Name: SetupInfDisplayPort01600000.exe 

 

New Features 

- Supports Infiniium Oscilloscope Software version 1.00 for 90000 Series oscilloscope. 

- Added option to supports Eye Diagram Test base on DisplayPort PHY Compliance Test 

Standard, Version 1. 

- Supports user configurable expert mode via “Expert Mode” configuration variable to allow 

loosen pre-test checking and reduce test time. Please refer to Programmer’s Reference for more 

details (see Help > Remote Interface). 

 

Modification 

- Minimum Infiniium Oscilloscope Software updated to version 5.40 for 80000 Series oscilloscope. 

- Updated the test matrix base on DisplayPort PHY Compliance Test Standard, Version 1.1. 

- Removed the support for non-compliance differential voltage level and pre-emphasis level 

configurations for all the tests. 

- Updated the test methodology for Frequency Long Term Stability Test. 

- Updated the Frequency Long Term Stability Test to run with SSC disabled only. 

- Updated the test methodology for Cable and Sink devices. 
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Bug Fixes 

- Fixed the issue of application crashes when the Comments fields contains multiple lines text. 
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Agilent U7232A Software Version 1.50 

 

Released Date: 5 December 2007 

Requirements category (e.g., operating system): Microsoft Windows XP 

Requirements category (e.g., minimum instrument 

software version): 

5.30 (80000 Series) 

File Name: SetupInfDisplayPort01500000.exe 

 

New Features 

- Supports test plan capability in the application which enable semi-automation of the test run. 

User is allowed to select multiple DUT configurations each time before running the test. The 

application will go through the selected configurations and ask the user to change the actual 

DUT configurations when different configurations required. 

- Supports Link Layer Test which is subdivided into three different sub-tests: 

o Bit Rate: A test to verify if the DUT can change the bit rate configuration from the lowest 

to the highest setting. 

o Level: A test to verify if the DUT can change the differential voltage level setting from the 

lowest to the highest setting. 

o Pre-Emphasis: A test to verify if the DUT can change the pre-emphasis level setting from 

the lowest to the highest setting. 

Modification 

- Updated the user interface of the Setup Wizard if Sink or Cable device is selected where user 

only allow to configure the data rate of the DUT. Other DUT configurations are disabled if Sink 

or Cable device is selected. 

- Improved the algorithm for PRBS pattern checker. 

 



71 / 72  Keysight D9040DPPC DisplayPort Compliance and Validation Test Application Release Notes 

 

 

Agilent U7232A Software Version 1.00 

 

Released Date: 20 August 2007 

Requirements category (e.g., operating system): Microsoft Windows XP 

Requirements category (e.g., minimum instrument 

software version): 

5.30 (80000 Series) 

File Name: SetupInfDisplayPort01000000.exe 
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